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Note the following details of the code protection feature on Microchip devices:

. Microchip products meet the specification contained in their particular Microchip Data Sheet.

. Microchip believes that its family of products is one of the most secure families of its kind on the market today, when used in the

intended manner and under normal conditions.

. There are dishonest and possibly illegal methods used to breach the code protection feature. All of these methods, to our
knowledge, require using the Microchip products in a manner outside the operating specifications contained in Microchip’s Data
Sheets. Most likely, the person doing so is engaged in theft of intellectual property.

. Microchip is willing to work with the customer who is concerned about the integrity of their code.

. Neither Microchip nor any other semiconductor manufacturer can guarantee the security of their code. Code protection does not

mean that we are guaranteeing the product as “unbreakable.”

Code protection is constantly evolving. We at Microchip are committed to continuously improving the code protection features of our
products. Attempts to break Microchip’s code protection feature may be a violation of the Digital Millennium Copyright Act. If such acts
allow unauthorized access to your software or other copyrighted work, you may have a right to sue for relief under that Act.

Information contained in this publication regarding device
applications and the like is provided only for your convenience
and may be superseded by updates. It is your responsibility to
ensure that your application meets with your specifications.
MICROCHIP MAKES NO REPRESENTATIONS OR
WARRANTIES OF ANY KIND WHETHER EXPRESS OR
IMPLIED, WRITTEN OR ORAL, STATUTORY OR
OTHERWISE, RELATED TO THE INFORMATION,
INCLUDING BUT NOT LIMITED TO ITS CONDITION,
QUALITY, PERFORMANCE, MERCHANTABILITY OR
FITNESS FOR PURPOSE. Microchip disclaims all liability
arising from this information and its use. Use of Microchip
devices in life support and/or safety applications is entirely at
the buyer’s risk, and the buyer agrees to defend, indemnify and
hold harmless Microchip from any and all damages, claims,
suits, or expenses resulting from such use. No licenses are
conveyed, implicity or otherwise, under any Microchip
intellectual property rights unless otherwise stated.

Microchip received ISO/TS-16949:2009 cetrtification for its worldwide
headquarters, design and wafer fabrication facilities in Chandler and
Tempe, Arizona; Gresham, Oregon and design centers in California
and India. The Company'’s quality system processes and procedures
are for its PIC® MCUs and dsPIC® DSCs, KEELOQ® code hopping
devices, Serial EEPROMs, microperipherals, nonvolatile memory and
analog products. In addition, Microchip’s quality system for the design
and manufacture of development systems is ISO 9001:2000 certified.

QUALITY MANAGEMENT SYSTEM
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Object of Declaration: MIC4684 2A Buck Regulator with Output Level Select Evaluation Board

EU Declaration of Conformity

This declaration of conformity is issued by the manufacturer.

The development/evaluation tool is designed to be used for research and development in a laboratory environment. This
development/evaluation tool is not a Finished Appliance, nor is it intended for incorporation into Finished Appliances that are made
commercially available as single functional units to end users under EU EMC Directive 2004/108/EC and as supported by the European
Commission's Guide for the EMC Directive 2004/108/EC (8th February 2010).

This development/evaluation tool complies with EU RoHS2 Directive 2011/65/EU.

This development/evaluation tool, when incorporating wireless and radio-telecom functionality, is in compliance with the essential
requirement and other relevant provisions of the R&TTE Directive 1999/5/EC and the FCC rules as stated in the declaration of conformity
provided in the module datasheet and the module product page available at www.microchip.com.

For information regarding the exclusive, limited warranties applicable to Microchip products, please see Microchip’s standard terms and
conditions of sale, which are printed on our sales documentation and available at www.microchip.com.

Signed for and on behalf of Microchip Technology Inc. at Chandler, Arizona, USA.

R . s L T
= Z

Rodger Richey Date
Director of Development Tools
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MICROCHIP

MiC4684 2A BUCK REGULATOR WITH
OUTPUT LEVEL SELECT
EVALUATION BOARD USER’S GUIDE

Preface

NOTICE TO CUSTOMERS

of the document.

All documentation becomes dated, and this manual is no exception. Microchip tools and
documentation are constantly evolving to meet customer needs, so some actual dialogs
and/or tool descriptions may differ from those in this document. Please refer to our website
(www.microchip.com) to obtain the latest documentation available.

Documents are identified with a “DS” number. This number is located on the bottom of each
page, in front of the page number. The numbering convention for the DS number is
“DSXXXXXXXXA”, where “XXXXXXXX” is the document number and “A” is the revision level

For the most up-to-date information on development tools, see the MPLAB® IDE online help.
Select the Help menu, and then Topics, to open a list of available online help files.

INTRODUCTION

This chapter contains general information that will be useful to know before using the
MIC4684 2A Buck Regulator with Output Level Select Evaluation Board. Items
discussed in this chapter include:

Document Layout

Conventions Used in this Guide
Recommended Reading

The Microchip Web Site
Customer Support

Document Revision History

DOCUMENT LAYOUT

This document describes how to use the MIC4684 2A Buck Regulator with Output
Level Select Evaluation Board as a development tool to emulate and debug firmware
on a target board. The manual layout is as follows:

Chapter 1. “Product Overview” — Important information about the MIC4684 2A
Buck Regulator with Output Level Select Evaluation Board.

Chapter 2. “Installation and Operation” — Includes instructions on installing and
starting the MIC4684 2A Buck Regulator with Output Level Select Evaluation
Board.

Appendix A. “Schematic and Layouts” — Shows the schematic and layout
diagrams for the MIC4684 2A Buck Regulator with Output Level Select Evaluation
Board.

Appendix B. “Bill of Materials (BOM)” — Lists the parts used to build the
MIC4684 2A Buck Regulator with Output Level Select Evaluation Board.

© 2017 Microchip Technology Inc. DS50002689A-page 7
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CONVENTIONS USED IN THIS GUIDE

This manual uses the following documentation conventions:

DOCUMENTATION CONVENTIONS

Description

Represents

Examples

Arial font:

Italic characters

Referenced books

MPLAB® IDE User’s Guide

Emphasized text

...is the only compiler...

Initial caps A window the Output window
A dialog the Settings dialog
A menu selection select Enable Programmer
Quotes A field name in a window or | “Save project before build”
dialog
Underlined, italic text with A menu path File>Save
right angle bracket
Bold characters A dialog button Click OK

A tab

Click the Power tab

N‘Rnnnn

A number in verilog format,
where N is the total number of
digits, Ris the radixand nis a
digit.

4'p0010, 2'hF1

Text in angle brackets < >

A key on the keyboard

Press <Enter>, <F1>

Courier New font:

Plain Courier New

Sample source code

#define START

Filenames autoexec.bat

File paths c:\mccl8\h

Keywords _asm, _endasm, static
Command-line options -Opa+, -Opa-

Bit values 0, 1

Constants 0xFF, ‘A’

Italic Courier New

A variable argument

file.o,where file can be
any valid filename

Square brackets [ ]

Optional arguments

mccl8 [options] file

[options]

Curly brackets and pipe
character: { | }

Choice of mutually exclusive
arguments; an OR selection

errorlevel {01}

Ellipses...

Replaces repeated text

var name [,
var name...]

Represents code supplied by
user

void main (void)

{
}

DS50002689A-page 8
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Preface

RECOMMENDED READING

This user’s guide describes how to use the MIC4684 2A Buck Regulator with Output
Level Select Evaluation Board. Another useful document is listed below. The following
Microchip document is available and recommended as a supplemental reference
resource:

* MIC4684 Data Sheet — “2A High-Efficiency SuperSwitcher™ Buck
Regulator” (DSM9999-012610)

THE MICROCHIP WEB SITE

Microchip provides online support via our web site at www.microchip.com. This web
site is used as a means to make files and information easily available to customers.
Accessible by using your favorite Internet browser, the web site contains the following
information:

* Product Support — Data sheets and errata, application notes and sample
programs, design resources, user’s guides and hardware support documents,
latest software releases and archived software

* General Technical Support — Frequently Asked Questions (FAQs), technical
support requests, online discussion groups, Microchip consultant program
member listing

* Business of Microchip — Product selector and ordering guides, latest Microchip
press releases, listing of seminars and events, listings of Microchip sales offices,
distributors and factory representatives

CUSTOMER SUPPORT

Users of Microchip products can receive assistance through several channels:

+ Distributor or Representative

* Local Sales Office

+ Field Application Engineer (FAE)
 Technical Support

Customers should contact their distributor, representative or field application engineer
(FAE) for support. Local sales offices are also available to help customers. A listing of
sales offices and locations is included in the back of this document.

Technical support is available through the web site at:
http://www.microchip.com/support.

DOCUMENT REVISION HISTORY
Revision A (October 2017)

« |nitial Release of this Document.

© 2017 Microchip Technology Inc. DS50002689A-page 9
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s MIC4684 2A BUCK REGULATOR
WITH OUTPUT LEVEL SELECT
EVALUATION BOARD USER’S GUIDE

MICROCHIP

Chapter 1. Product Overview

1.1 INTRODUCTION

This chapter provides an overview of the MIC4684 2A Buck Regulator with Output
Level Select Evaluation Board and covers the following topics:

» MIC4684 2A Buck Regulator with Output Level Select Evaluation Board Overview
+ MIC4684 2A Buck Regulator with Output Level Select Evaluation Board Features

» What the MIC4684 2A Buck Regulator with Output Level Select Evaluation Board
Kit Contains

1.2 MIC4684 2A BUCK REGULATOR WITH OUTPUT LEVEL SELECT
EVALUATION BOARD OVERVIEW

The MIC4684 2A Buck Regulator with Output Level Select Evaluation Board is a
constant-frequency, non-synchronous buck solution featuring a voltage-mode control
architecture. The MIC4684 operates over an input supply range of 4V to 30V. The
output voltage is adjustable down to 1.235V. The device operates with a constant
switching frequency of 200 kHz.

Figure 1-1 shows the evaluation board’s interfaces and connectors.

Board u/ level sel

C€ ™1

FIGURE 1-1: MIC4684 2A Buck Regulator with Output Level Select Evaluation
Board Overview.

© 2017 Microchip Technology Inc. DS50002689A-page 11
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1.3 MIC4684 2A BUCK REGULATOR WITH OUTPUT LEVEL SELECT
EVALUATION BOARD FEATURES

The MIC4684 2A Buck Regulator with Output Level Select Evaluation Board features:

* Four selectable output voltages: 1.8V, 2.5V, 3.3V and 5V

A footprint for a feed forward diode for the booststrap which improves the system
efficiency

» Alogic level enable (EN) signal can be used to enable or disable the controller

» Frequency foldback for short circuit conditions

The basic parameters of the evaluation board are:

* Input: 4V to 30V (Optimized for 12V)
» Output: 1.8V, 2.5V, 3.3V or 5V selectable trough jumper J1 at 2A (default option is
set to 5V)

» Switching Frequency: 200 kHz

1.4 WHAT THE MIC4684 2A BUCK REGULATOR WITH OUTPUT LEVEL SELECT
EVALUATION BOARD KIT CONTAINS

The MIC4684 2A Buck Regulator with Output Level Select Evaluation Board includes
the following items:

* MIC4684 2A Buck Regulator with Output Level Select Evaluation Board
(ADM00821)

* Important Information Sheet

DS50002689A-page 12 © 2017 Microchip Technology Inc.
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Chapter 2. Installation and Operation

21 SYSTEM AND CONFIGURATION REQUIREMENTS

The MIC4684 2A Buck Regulator with Output Level Select Evaluation Board requires
only a single power supply with at least 2A current capability. The output load can either
be a passive or an active load.

Note: The MIC4684 2A Buck Regulator with Output Level Select Evaluation
Board does not have reverse polarity protection. Applying a negative
voltage to the V| and GND terminals may damage the device. The
maximum Vy of the board is rated at 30V. Exceeding 30V on the V| could
damage the device.

2.2 BOARD SETUP

Follow these steps prior to using the MIC4684 2A Buck Regulator with Output Level
Select Evaluation Board:

1. Connect a supply to the V| and GND terminals, paying careful attention to the
polarity and the supply range (4V < V|y < 30V). Monitor I,y with a current meter
and input voltage at V|5 and GND terminals with voltmeter. Do not apply power
until Step 5.

2. Connect a jumper to the top position of jumper J1. This will set the output of the
converter to 5V.

3. Connectaload to the Vo1 and GND terminals. The load can be either a passive
(resistive) or an active (electronic) type. A current meter may be placed between
the VoyT terminal and load to monitor the output current. Ensure the output
voltage is monitored at the Vg terminal.

4. Enable input. An EN connector is provided on the evaluation board for users to
easily access the enable feature. Applying an external logic signal on the EN pin
to pull it low, or using a jumper to short the EN pin to GND, will shut off the output
of the MIC4684 2A Buck Regulator with Output Level Select Evaluation Board.

5. Turn on the V| supply and verify that the output voltage is regulated to the
specific selected voltage.

© 2017 Microchip Technology Inc. DS50000000A-page 13
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2.3 CIRCUIT DESCRIPTION

This section describes the working principles and limitations that should be taken into
account when using the MIC4684 2A Buck Regulator with Output Level Select
Evaluation Board. External components have been selected in order to optimize
performance for the specific conditions of V| = 12V and Vg1 = 5V.

Although the application behaves correctly for other output and input voltages, further
optimization (fine tuning of the inductor and output capacitors) can be done in order to
improve efficiency and transients response.

—DF
D2/DNP
\ BST j
url)Nto 30V VIN —_— C1
L1
SW—e— Y Y T l I m Vour
C
MIC4684 R1 C8/DNPI ouT
EN T =
FB
[e—eo—o 9]
'Z§ D1 Ce (I ) o]
-7 GND %Rs R4%R5 R6
-
I: jpe— j— jpe— je— jp—
FIGURE 2-1: Evaluation Board Circuit Description.

2.3.1 Feedback Resistors

The output voltages available on the MIC4684 2A Buck Regulator with Output Level

Select Evaluation Board are: 1.8V, 2.5V, 3.3V and 5V which are selectable using jumper
J1.

Voltages other than the ones already available can be set by modifying Ry resistors
according to Equation 2-1.

EQUATION 2-1:
Ry XV peR
Rpor = %4 74
OUT '"REF
Where:

VREF = 1.235V

Note: The output voltage should not be set to exceed 10V due to the 10V voltage
rating on the output capacitors.

2.3.2 SW Node

Test point TP9 (Vgy) is placed for monitoring the switching waveform, one of the most
critical waveforms for the converter.

DS50000000A-page 14 © 2017 Microchip Technology Inc.



Installation and Operation

233 Auxiliary Bootstrap

The MIC4684 2A Buck Regulator with Output Level Select Evaluation Board features
an optional booststrap diode that improves the system efficiency by providing an exter-
nal bias source directly to the main pass element, thus reducing Vgar. This also allows
the MIC4684 to be used in very low head-room applications (5 V| to 3.3 VouT)-

234 Safe Operating Area

Depending on the conditions (input voltage, output voltage and temperature) and the
configuration of the board the safe operating area is summarized below.

25
e
2 2 / \
S 1.5 e
5 /
o
5 1
=
o 0.5 —T=25C
) —T=60C
o T T T T
5 10 15 20 25 30
Input Voltage[V]
FIGURE 2-2: VOUT = 5V, Standard Configuration.
25
T’ I
t
215
=1
o
5 1
i)
3 0.5 —T=25¢C
) —T=60C
o T T T T
5 7 9 1 13 15
Input Voltage[V]
FIGURE 2-3: VOUT = 5V, Feed Forward Diode Configuration.
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25
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“t’ 1.5
=1
(&]
5 1
s
=
S5 —T=25C
—T=60C
0 T T T T
5 10 15 20 25 30
Input Voltage[V]
FIGURE 2-4: VOUT = 3.3V, Standard Configuration.
25
—
< 2 / //kr
'E' /
“t’ 1.5
=1
(6]
5 1
s
=3
o5 —T=25C
—T=60C
0 T T T T
5 7 9 11 13 15
Input Voltage[V]
FIGURE 2-5: VOUT = 3.3V, Feed Forward Diode Configuration.
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3
._|2.5
< /’_A
T 2 —
S //
315 /
5
S 17
3
05 —T=25C
—T=60C
0 T T T T
5 10 15 20 25 30
Input Voltage[V]
FIGURE 2-6: VOUT = 2.5V, Standard Configuration.
3
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T 2
Ny
3 1.5
5
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3
0.5 —T=25C
—T=60C
0 T T T T
5 7 9 1 13 15
Input Voltage[V]
FIGURE 2-7: VOUT = 2.5V, Feed Forward Diode Configuration.
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FIGURE 2-8: VOUT = 1.8V, Standard Configuration.
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FIGURE 2-9: VOUT = 1.8V, Feed Forward Diode Configuration.
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MICROCHIP
Appendix A. Schematic and Layouts

A1 INTRODUCTION
This appendix contains the following schematics and layouts for the MIC4684 2A Buck
Regulator with Output Level Select Evaluation Board:
» Board — Schematic
» Board — Top Silk Layer
* Board — Top Copper Layer
» Board — Bottom Copper Layer

© 2017 Microchip Technology Inc. DS50002689A-page 19
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Schematic and Layouts
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A.5 BOARD -BOTTOM COPPER LAYER

© 2017 Microchip Technology Inc. DS50002689A-page 23



MIC4684 2A Buck Regulator with Output Level Select Evaluation Board User’s Guide

NOTES:

DS50002689A-page 24 © 2017 Microchip Technology Inc.



MICROCHIP

MIC4684 2A BUCK REGULATOR
WITH OUTPUT LEVEL SELECT

EVALUATION BOARD USER'’S GUIDE

Appendix B. Bill of Materials (BOM)

TABLE B-1: BILL OF MATERIALS (BOM) FOR MIC4684 2A BUCK REGULATOR WITH OUTPUT
LEVEL SELECT EVALUATION BOARD (ADM00821)(")
Qty. | Reference Description Manufacturer Part Number
1 C1 Capacitor ceramic 0.33 uF, 50V, 10%, X7R, | TDK Corporation C2012X7R1H334K125AA
SMD, 0805
2 C2,C3 Capacitor ceramic 10 pF, 35V, 20%, X7R, Taiyo Yuden Co., Ltd. | GMK325AB7106MM-T
SMD, 1210
2 C4, C6 Capacitor ceramic 0.1 pF, 50V, 20%, X7R, TDK Corporation C1608X7R1H104M
SMD, 0603
1 C5 Capacitor tantalum 330 pF, 6.3V, 20%, KEMET T520D337MO06ATE045
45 MQ, SMD D
1 Cc7 Capacitor ceramic 10 uF, 10V, 10%, X7R, TDK Corporation C2012X7R1A106K125AC
SMD, 0805
1 C8 Capacitor ceramic 47 pF, 50V, 5%, NPO, KEMET C0603C470J5GACTU
SMD, 0603
DO NOT POPULATE
1 D1 Diode schottky, B340A 500 mV, 3A, 40V, Diodes B340A-13-F
DO-214AC_SMA Incorporated®
1 D2 Diode schottky, MBRX140-TP 550 mV, 1A, Micro MBRX140-TP
40V, SMD SOD-123 Commercial
DO NOT POPULATE Components
1 J1 Connector header-2.54 male 2 x 4, gold, Wourth Elektronik 61300821121
5.84MH, TH, vertical
1 J2 Connector header-2.54 male 1 x 3, tin, Samtec, Inc. TSW-103-07-T-S
5.84MH, TH, vertical
1 L1 Inductor 47 pyH 3A, 20%, SMD, 12x12x 8 Waurth Elektronik 744770147
4 PAD1, Mechanical hardware rubber pad, 3M SJ5382
PAD2, hemisphere, D6.4 H1.9, clear
PAD3,
PAD4
1 PCB1 MIC4684 2A Buck Regulator with Output Microchip 04-10632-R1
Level Select Evaluation Board Technology Inc.
Printed Circuit Board
1 R1 Resistor TKF, 3.01k, 1%, 1/10W, SMD, 0603 | Panasonic® - ECG ERJ-3EKF3011V
R2 Resistor TF, 100k, 1%, 1/8W, SMD, 0603 Vishay MCT06030C1003FP500
Intertechnology, Inc.
1 R3 Resistor TKF, 6.49k, 1%, 1/16W, SMD, 0603 | Panasonic® - ECG ERJ-3EKF6491V
1 R4 Resistor TKF, 2.94k, 1%, 1/10W, SMD, 0603 | Panasonic® - ECG ERJ3EKF2941V
1 R5 Resistor TKF, 1.78k, 1%, 1/4W, SMD, 0603 | Panasonic® - ECG ERJPA3F1781V
1 R6 Resistor TKF, 976R 1% 1/4W SMD 0603 Panasonic® - ECG ERJPA3F9760V
1 TP1 CON TP LOOP, Blue, TH Keystone 5127
Electronics Corp.
Note 1: The components listed in this Bill of Materials are representative of the PCB assembly. The released BOM

used in manufacturing uses all RoHS-compliant components.
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TABLE B-1:  BILL OF MATERIALS (BOM) (CONTINUED)FOR MIC4684 2A BUCK REGULATOR
WITH OUTPUT LEVEL SELECT EVALUATION BOARD (ADM00821)(")

Qty. | Reference Description Manufacturer Part Number
2 TP2, TP3 CON TP LOOP, Red, TH Keystone 5010
Electronics Corp.
2 TP4, TP5 CON TP LOORP, Black, TH Keystone 5011
Electronics Corp.
1 U1 MCHP Analog Switcher Buck, 1.25V to Microchip MIC4684YM
28.3V, MIC4684YM, SOP-8 Technology Inc.

Note 1: The components listed in this Bill of Materials are representative of the PCB assembly. The released BOM

used in manufacturing uses all RoHS-compliant components.
TABLE B-2: BILL OF MATERIALS (BOM) - MECHANICAL PARTS FOR MIC4684 2A BUCK

REGULATOR WITH OUTPUT LEVEL SELECT EVALUATION BOARD (ADM00821)(")

Qty. Reference Description Manufacturer Part Number
2 JP1, JP2 Mechanical hardware jumper, 2.54 mm |3M 969102-0000-DA
1x2
1 LABEL3 LABEL, ASSY W/REV LEVEL (SMALL
MODULES) PER MTS-0002

Note 1: The components listed in this Bill of Materials are representative of the PCB assembly. The released BOM
used in manufacturing uses all RoHS-compliant components.
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